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1 
1 OVERVIEW 
This technical guide provides an overview and description of the features of the process control system, as 

well as links to documents and websites that will be helpful in the selection of device/system configurations 

needed to configure the system, in developing programs, and in monitoring the system. 

In addition, the replacement procedures from the MELSEC-Q series and links to information on software and 

sample libraries used to configure the system are provided as supplemental information. 

1.1 Features of MELSEC Process Control 
Implementing loop control (process control) and sequential control (electrical control) with a single 

CPU module 

• Both loop control and sequential control can be executed at high speed with a single CPU module (process 

CPU). 

Reference: MELSEC iQ-R Process CPU Module User's Manual (Application)  14.2 Process Control Function 

 

Lineup of products including channel isolated analog module necessary for process control 

• Our lineup of products includes channel isolated analog module and pulse input module that meet the 

needs for disconnection detection function and multi-channel configurations. 

Reference: MELSEC iQ-R Module Configuration Manual  1.2 Lists of Configuration Devices  MELSEC iQ-R series  

Intelligent function module 

 

Improving reliability with redundant system 

• A highly reliable system can be configured by adopting redundant CPU modules, power supply modules, 

network modules, and main base units, as well as tracking cables, extension cables, and network cables. 

• Redundancy of the CPU module is achieved through a combination of a process CPU module (RnPCPU) 

and a redundant function module (R6RFM). 

• Redundancy of the remote head module (RJ72GF15-T2) required for the remote I/O station is also 

supported. 

Reference: MELSEC iQ-R Module Configuration Manual  1.1 Overall Configuration  Redundant system 

 

Integrated engineering of loop control (process control) and sequential control (electrical control) by 

GX Works3 

• Loop control programs with high readability can be easily created by combining function blocks (process 

control FBs) using the FBD/LD language. 

• Relay circuit-based sequential control (electrical control) programs can be easily created using the ladder 

language. 

Reference: MELSEC iQ-R Programming Manual (Process Control Function Blocks/Instruction)  1 PROCESS CONTROL 

FUNCTION BLOCKS AND PROCESS CONTROL INSTRUCTIONS 

 

Maintenance functions for resolving malfunctions 

• When an analog module or I/O module malfunctions, it can be replaced online without stopping the process 

CPU. 

• The backup/restoration functions allow the system to be restored without the need for the engineering tool 

when a CPU that has malfunctioned is replaced with a new one. 

Reference: MELSEC iQ-R Online Module Change Manual  1 OVERVIEW 

 

Configuration of comfortable monitoring control system with GENESIS64 integration 

• You can configure a highly functional monitoring control system that meets a variety of needs through 

integration with GENESIS64. 

https://www.mitsubishielectric.com/fa/products/software/visualisation/genesis64/index.html 
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1.2 System Configuration 
With MELSEC process control, the I/O configuration can be selected from a local I/O (extension base) 

configuration for close proximity placement, remote I/O configuration for remote placement, or a combination 

of these, depending on the scale of the target system and other requirements. 

Reference: MELSEC iQ-R Module Configuration Manual  1.1 Overall Configuration  Redundant system 

 

Local I/O (extension base) configuration 
• A local I/O (extension base) configuration can be configured by mounting I/O and analog modules for the 

number suitable for the system scale on the extension base unit. 

• In comparison with the remote I/O configuration in which I/O connections are made over networks, the I/O 

response is faster, which can reduce the I/O hold time when the systems are switched in a redundant 

system (redundant mode). 

 
 

Reference: MELSEC iQ-R Module Configuration Manual  1.1 Overall Configuration  Redundant system  Redundant system 

with redundant extension base unit 
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Remote I/O configuration (using remote head module) 
• A remote I/O configuration can be built by mounting a remote head module and I/O and analog modules for 

the number suitable for the system scale on the remote station and by connecting the remote head module 

to the CC-Link IE Field network. 

• You can configure a redundant system by mounting two remote head modules on a remote station so that 

one module takes over when the other one malfunctions. 

• Multiple remote stations can be controlled by a single process CPU (a single set in a redundant system). 

 
 

Reference: MELSEC iQ-R Module Configuration Manual  1.1 Overall Configuration  Redundant system  Redundant system for 

CC-Link IE Field Network 
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Remote I/O configuration (using remote I/O module) 
• A remote I/O configuration can be built by applying remote I/O and analog modules compatible with CC-Link 

IE Field network. 

• Monitoring and controlling the distributed devices are possible. 

• Optimal for small-scale systems. 

 
 

Reference: MELSEC iQ-R Module Configuration Manual  1.1 Overall Configuration  Redundant system  Redundant system for 

CC-Link IE Field Network 
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1.3 Lineup 
This section introduces our lineup of process CPUs, network modules, and analog modules. Visit the 

MITSUBISHI ELECTRIC Factory Automation website for information on our lineup of latest products and other 

products. 

 

Process CPUs and redundant function modules 
The process CPU is a CPU module that can achieve process control and high-speed electrical control with 

only one CPU. Depending on the scale of control (number of control loops), we offer four models that support 

programs ranging from 80 K steps to 1200 K steps, covering a wide range of applications from equipment 

process control to plant process control. 

A redundant system can be configured by combining a process CPUs with redundant function module and can 

be applied to a system that requires high reliability. 

 

 
 

Reference: MELSEC iQ-R Module Configuration Manual  1.1 Overall Configuration  Redundant system  Redundant 

configuration of basic systems 

Reference: MELSEC iQ-R Module Configuration Manual  1.2 Lists of Configuration Devices  MELSEC iQ-R series 

Reference: MELSEC iQ-R CPU Module User's Manual (Startup)  2 SPECIFICATIONS  2.1 CPU Module  Process CPU 

Reference: MELSEC iQ-R CPU Module User's Manual (Startup)  2 SPECIFICATIONS  2.4 Redundant Function Module 
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Network modules 
We offer a lineup of network modules that meet the requirements of many different system applications. 

In a redundant system, a highly reliable network can be configured by reducing single points of failure with 

redundant connections using the CC-Link IE Field network and remote head redundancy. 

 

 

 

Reference: MELSEC iQ-R Module Configuration Manual  1.2 Lists of Configuration Devices  MELSEC iQ-R series  Intelligent 

function module 

 

Redundant system support function 

Reference: MELSEC iQ-R CC-Link IE Controller Network User's Manual (Application)  1.7 Redundant System Function 

Reference: MELSEC iQ-R CC-Link IE Field Network User's Manual (Application)  1.6 Redundant System Function 

Reference: MELSEC iQ-R CC-Link System Master/Local Module User's Manual (Application)  APPENDICES 8 How to Use 

Standby Master Function in Redundant System 

Reference: MELSEC iQ-R MELSECNET/H Network Module User's Manual (Application)  1.5 Redundant System 

Function(RJ71LP21-25 Only) 

Reference: MELSEC iQ-R Ethernet User's Manual (Application)  1.18 Redundant System Function 

Reference: MELSEC iQ-R Serial Communication Module User's Manual (Application)  APPENDIX 8 Using MODBUS in a 

Redundant System 

Reference: MELSEC iQ-R Profibus-DP Module User's Manual (Application)  1.13 Redundant System Function 

Reference: MELSEC iQ-R DeviceNet Master/Slave Module User's Manual (Application)  APPENDICES 6 Using the Module in the 

Redundant System with Redundant Extension Base Unit 

FL-net (OPCN-2) Interface module  Model ER-1FL2-T  User's Manual (Detailed Edition) 

https://www.mitsubishielectricengineering.com/sales/fa/meefan/product_information/products/er-1fl2-t.html 
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Reference: MELSEC iQ-R OPC UA Server Module User's Manual (Application)  APPENDIX 11 Use in a Redundant System 

Reference: MELSEC iQ-R High Speed Data Logger Module User's Manual (Application)  APPENDIX 16 When Using a Redundant 

System 

Reference: MELSEC iQ-R C Intelligent Function Module User's Manual (Application)  APPENDIX 6 Use in a Redundant System 

 

Analog modules 
We offer a lineup of analog modules that meet the requirements of many different system applications. 

(1) For local I/O (extension base) configuration and remote I/O configuration (using 
remote head module) 

We offer multi-channel modules, channel isolated modules, and modules compatible with HART 

communication. 

Reference: MELSEC iQ-R Module Configuration Manual  1.2 Lists of Configuration Devices  MELSEC iQ-R series  Intelligent 

function module 

Analog input 

 

Reference: MELSEC iQ-R Channel Isolated Analog-Digital Converter Module User's Manual (Startup) 

Reference: MELSEC iQ-R Channel Isolated Analog-Digital Converter Module User's Manual (Application) 

Reference: MELSEC iQ-R Channel Isolated Analog-Digital Converter Module (With Signal Conditioning Function) User's Manual 

(Startup) 

Reference: MELSEC iQ-R Channel Isolated Analog-Digital Converter Module (With Signal Conditioning Function) User's Manual 

(Application) 

Reference: MELSEC iQ-R Channel Isolated Thermocouple Input Module/Channel Isolated RTD Input Module User's Manual 

(Startup) 

Reference: MELSEC iQ-R Channel Isolated Thermocouple Input Module/Channel Isolated RTD Input Module User's Manual 

(Application) 

Reference: MELSEC iQ-R Analog-Digital Converter Module User's Manual (Startup) 

Reference: MELSEC iQ-R Analog-Digital Converter Module User's Manual (Application) 

Reference: MELSEC iQ-R HART-Enabled Analog-Digital Converter Module User's Manual (Startup) 

Reference: MELSEC iQ-R HART-Enabled Analog-Digital Converter Module User's Manual (Application) 
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Analog output and pulse input 

 

Reference: MELSEC iQ-R Channel Isolated Digital-Analog Converter Module User's Manual (Startup) 

Reference: MELSEC iQ-R Channel Isolated Digital-Analog Converter Module User's Manual (Application) 

Reference: (Startup) MELSEC iQ-R Channel Isolated Pulse Input Module User's Manual 

Reference: (Application) MELSEC iQ-R Channel Isolated Pulse Input Module User's Manual 

Reference: (Startup) MELSEC iQ-R Digital-Analog Converter Module User's Manual 

Reference: (Application) MELSEC iQ-R Digital-Analog Converter Module User's Manual 

 

(2) For remote I/O configuration (using remote I/O module) 

Only channel non-isolated modules are available. 

 

Analog input 

 

Reference: CC-Link IE Field Network Analog-Digital Converter Module User's Manual 

Reference: CC-Link IE Field Network Analog-Digital Converter Module (e-CON Type) User's Manual 

 

Analog output 

 

Reference: CC-Link IE Field Network Digital-Analog Converter Module User's Manual 

Reference: CC-Link IE Field Network Digital-Analog Converter Module (e-CON Type) User's Manual 

 

Number 
of 

channels

Current/voltage output

High-speed

16 R60DA16-G

8 R60DA8-G

8

4 R60DA4

Channel

isolated

Channel

non-

isolated

Current 

output

R60DAH4

R60DAI8 R60DAV8

Voltage 

output

RD60P8-G

Pulse input

Number 
of 

channels

Current/voltage 

input

8

4

NZ2GF2B-60AD4

Channel

non-

isolated

Current input

NZ2GFCE-60ADI8 NZ2GFCE-60ADV8

Voltage input

Number 
of 

channels

Current/voltage 

output

8

4

NZ2GF2B-60DA4

Channel

non-

isolated

Current output

NZ2GFCE-60DAI8 NZ2GFCE-60DAV8

Voltage output



 

 
2 SYSTEM SELECTION AND CONFIGURATION 

2.1 System Selection 11 

2 

2 SYSTEM SELECTION AND CONFIGURATION 

2.1 System Selection 
Use FA Integrated Selection Tool to select a system. 

MELSEC iQ-R programmable controllers, remote I/O modules, FREQROL inverters, GOTs, etc. can be 

selected. 

 

https://www.mitsubishielectric.com/fa/products/select/index.html 

 

Use the selection tool for time and wire saving devices for programmable controllers to select wiring devices. 

Time and wire saving devices provided by Mitsubishi Electric Engineering can be selected. 

https://www.mitsubishielectricengineering.com/sales/fa/meefan/wire_saving_devices/selection_tool/ 

2.2 System Configuration 
 

Example of actual system configuration 

Refer to the following training manual for the FATEC training school. 

Training School (FA) Service & Support | Mitsubishi Electric FA 

https://www.mitsubishielectric.com/fa/download/search.page?mode=schooltext&kisyu=/school_text&q=SH-082368ENG 

• Mitsubishi Programmable Controllers Training Manual Redundant System Basic Course (SH-082369ENG)  (4 NETWORK 

CONFIGURATION FOR REDUNDANT SYSTEMS) 
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3 PROGRAMMING AND OPERATION CHECK 
ON HMI 

3.1 Programming with the Process Control Function of GX 
Works3 

Refer to the following manual for information on procedures from creating a project using the process control 

function of GX Works3 to operation check. 

Reference: MELSEC iQ-R Programming Manual (Process Control Function Blocks/Instructions)  1 OVERVIEW  3 PROCEDURE 

BEFORE USING PROCESS CONTROL FUNCTION BLOCK 

 

Configuration of programming tool window (window layout can be changed) 

 
 

A. Actual program example 

Refer to the following training manual for the FATEC training school. 

Search for Manuals Others Training Manual │ Mitsubishi Electric FA 

https://www.mitsubishielectric.com/fa/download/search.page?mode=schooltext&kisyu=/school_text&q=SH-082349ENG 

• MELSEC iQ-R Process Control Basic Course (SH-082349ENG)  (5 CREATING A PROCESS CONTROL PROGRAM USING GX 

Works3) 

 

B. Sample programs and glossaries 

Reference: MELSEC PROCESS CONTROL Technical Guide/Sample Programs and Glossaries 
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C. FAQ 

The following lists frequently asked questions and answers about projects using the process control function. 

 

C-1. Precautions for converting programs 

Q1 Which conversion operations can be used for converting a program for the process control function of 

GX Works3? 

A1 To convert a program for the process control function of GX Works3, use either [Rebuild all (reassignment)] or 

[Online program change]. Refer to the following manuals for information on changing conversion settings. 

Reference: 2018-05_Differences of PX Developer and GX Works3 process control functions (FA-A-0236)  

2.5 Converting Programs 

Reference: GX Works3 Operating Manual 6.11 Converting Programs  Converting a program file with the 

process control extension enabled 

Q2 What are the conditions that requires converting (reassigning) all programs when converting a program? 

A2 Refer to the following manual for information on the conditions that requires converting (reassigning) all programs. 

Reference: GX Works3 Operating Manual 6.11 Converting Programs  Operations that requires a 

conversion for all programs 

 

C-2 Precautions for writing data to programmable controllers and starting simulations 

Q1 How can I write the process control project using GX Works3? 

A1 File registers are used for the process control function of GX Works3. Do not write all project files at once. Write 

only the CPU parameters first, and then reset or turn off and on the CPU. Then, perform the normal writing process. 

Reference: GX Works3 Operating Manual 13.1 Writing/Reading Programmable Controller Data  File 

register 

Q2 The faceplate display turns completely black and displays "FUNC Mismatch" during data writing to 

programmable controllers or when starting simulations. How can I resolve this issue? 

A2 Perform the correct writing procedure as described in the answer to Q1. If data is written using any other procedure, 

the faceplate display turns completely black and displays "FUNC Mismatch". 

"FUNC Mismatch" is displayed only in GX Works3 Ver. 1.120A or later. 

We recommend setting the following option to "No" when using the process control function of GX Works3. This 

can reduce errors in program writing at the time of starting simulations. 

[Tool] → [Options] → [Simulation] → [Automatically write programs and parameters when starting simulation] 

 

C-3 Tag FB parameters 

Q1 Changes to FB default value settings are not applied to programmable controllers. 

A1 During online operation, change the FB current values in the watch window. 

To write data to a programmable controller with the FB default value settings changed, convert (reassign) all 

programs when converting a program. Refer to the following manual for details on the precautions for applying 

changes. 

Reference: MELSEC iQ-R Programming Manual (Process Control Function Blocks/Instructions)  3.6 

Converting and Writing 

Q2 Layout of tag FB parameters is different between PX Developer and GX Works3.  

A2 In PX Developer, both public variables and tag data in tag FBs are displayed as ".*". In GX Works3, though, public 

variables and tag data are displayed in different formats. "tag name_FB.*" is the format used for public variables 

(operation constants), and "tag name.*" is the format used for tag data. Refer to the following manuals for detailed 

information on public variables (operation constants) and tag data. 

Reference: MELSEC iQ-R Programming Manual (Process Control Function Blocks/Instructions)  5 TAG FB 

Reference: MELSEC iQ-R Programming Manual (Process Control Function Blocks/Instructions)  

APPENDICES 1 Tag Data List 

Reference: MELSEC iQ-R Programming Manual (Process Control Function Blocks/Instructions)  3.4 

Editing an FBD/LD Program for Process Control  Specifying tag data and public variables 

Q3 When performing a device check for global label assignment in GX Works3, a device overlap occurs in 

the global label "M+PTAG". Provide more details. 

A3 In the process control function of GX Works3, the user-defined tag FBs use the system resource areas R2700 to 

R2829 (130 words) for internal processing. 

Since these areas are shared among multiple user-defined tag FBs, a device overlap may occur; however, user-

defined tag FBs do not use these areas simultaneously, so they operate normally. 

If a device overlap occurs with a global label other than "M+PTAG", change the assigned device of the global label. 
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3.2 GOT Screen Generator 
GOT2000 screens, such as faceplates and tuning screens, can be automatically generated from the projects 

created with the process control function of GX Works3 (projects with process control tag FBs). Settings for 

devices assigned to tag data do not need to be configured and programs do not need to be created for the 

automatically generated screens. Monitoring can be performed just by connecting the CPU to the GOT2000. 

 

Note that only the CPU connected to the host station can be monitored. Multiple CPUs connected to other 

stations cannot be monitored. 

 

Reference: GX Works3 Operating Manual 14.13 Checking Tag Data  PX Developer Monitor Tool interaction 

Reference: PX Developer Version1 Operating Manual (GOT Screen Generator)  4 GENERATION PROCEDURES OF SCREEN 

PROJECT 

Reference: PX Developer Version1 Operating Manual (Monitor Tool)  9.4 Monitor Target Project Setting 

 
 

A. Actual screen examples 

Refer to the following training manual for the FATEC training school. 

Training School (FA) Service & Support | Mitsubishi Electric FA 

https://www.mitsubishielectric.com/fa/download/search.page?mode=schooltext&kisyu=/school_text&q=SH-082349ENG 

• MELSEC iQ-R Process Control Basic Course (SH-082349ENG)  (6.3 Monitoring via GOT  Auto generation of GOT screen) 

 

B. FAQ 

The following lists frequently asked questions and answers about the GOT screen generator. 

 

B-1 GOT screen generation 

Q Changes in a project using the process control function of GX Works3 are not applied to the GOT 

screens. 

A Reload the latest version of the GX Works3 project (*.FADB) into PX Developer Monitor Tool, and then generate 

the GOT screens. 
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3.3 GT SoftGOT Integration Function 
The standard monitoring function of PX Developer Monitor Tool and GT SoftGOT2000 graphic screens can 

call each other1, which can significantly reduce the time needed to create process control monitoring screens 

for personal computers. 

If GOT2000 monitoring screens have already been created for onsite monitoring, the screens can be reused. 

 

Reference: GT SoftGOT2000 Version1 Operating Manual  4.15 Interaction with PX Developer 

 

 

 

  

 
1 PX Developer Ver. 1.40S or later is required for this function. 
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3.4 GENESIS64 Process Control Integration Function 
Integration with GENESIS64 allows you to configure advanced monitoring and control systems. 

GENESIS64 has basic functions such as graphic monitoring, trend display, alarm and event management, 

and report generation, as well as functions such as high-speed data collection, energy management, 

scheduling, and wide-area monitoring, contributing to the overall monitoring of the factory and enhancing 

customers' productivity and quality. 

 
 

Support for Designing Process Control Screens with Asset Builder 

Asset Builder is a function that supports you in configuring monitoring systems using AssetWorX functions 

with GraphWorX64 template screens. Key features include: 

• Availability of template screens for various purposes such as process automation 

• Automatic generation of elements in plants and factories as AssetWorX devices 

• Automatic generation of communication tag settings 

• Automation assignment of communication tag settings to AssetWorX devices 

Process control programs created in the engineering software GX Works3 can be loaded into GENESIS64 to 

create monitoring screens for process control systems. Because the process control tag information is 

automatically assigned to faceplates and tuning screens, configuring the settings again in GENESIS64 is not 

required. 

Refer to the following websites for detailed information on configuration procedures. 

https://documentation.iconics.com/v10.97.3/Content/Apps/WBDT/AssetBuilder/Quick_Start/Process_Automation_Template_Ver

sion/Create_Instances.htm 

 

https://documentation.iconics.com/v10.97.3/Content/Apps/WBDT/AssetBuilder/Quick_Start/Process_Automation_Template_Ver

sion/Operate_screens.htm 
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4 REPLACING MELSEC-Q SERIES WITH 
MELSEC iQ-R SERIES 

4.1 System Replacement 
Refer to the following documents when replacing systems. 

 

Reference: 2023-09_MELSEC-Q Series to MELSEC iQ-R Series Migration Guide 

Reference: 2024-08_MELSECNET/H Transition Handbook (MELSEC-Q Series) 

 

The migration tool from the MELSEC-Q Series to the MELSEC iQ-R Series can be used to select the modules 

after replacement. 

 

 
 

https://www.mitsubishielectric.com/fa/ssl/products/cnt/plcq/ex/select/q2rmigration/q2rmigration.html 
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4.2 Replacement from PX Developer Format Project 
PX Developer projects and GX Works2 projects can be converted and used in GX Works3. 

To open a PX Developer format project, select [Project] → [Open Other Format File] → [PX Developer Format] 

in GX Works3. The CPU model will be changed from a PX Developer-compatible model (Q series universal 

model process CPU or redundant CPU) to a GX Works3-compatible model (iQ-R series process CPU). 

 

Reference: GX Works3 Operating Manual  3.2 Creating a Project File  Opening a PX Developer format project 

 

Parts that cannot be converted to GX Works3 format requires separate action after the file is read. 

Reference: GX Works3 Operating Manual  APPENDIX 7 Replacement of Another Format Project  Replacement of a PX 

Developer format project 

Reference: 2018-05_Differences of PX Developer and GX Works3 process control functions (FA-A-0236)  4 LIBRARY 

Reference: 2023-09_MELSEC-Q Series to MELSEC iQ-R Series Migration Guide  11.1 Project Migration Procedure  PX 

Developer projects 

Reference: 2023-09_MELSEC-Q Series to MELSEC iQ-R Series Migration Guide  11.2 Instruction Migration  Migration of PX 

Developer instructions 

 

Procedures for converting and opening PX Developer format 
projects 
The following describes the procedures for converting and opening PX Developer format projects in GX 

Works3. 

 

1) Select [Project] → [Open Other Format File] → [PX Developer Format] → [Open Project]. 
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2) Select a PX Developer project and then click [Open]. 

 
 

3) Click [OK]. If the message "Operation to open PX Developer format project was canceled." appears, 

jump to step 7), finish the procedure, and then return to step 1) and redo the entire procedure. 
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4 

4) Click [Yes]. 

 
 

5) Click [OK]. 

 
 

6) Check the change results displayed in the "Output" window. Check the parameter settings of the 

modules after replacement. If any modules are replaced with general intelligent modules, change the 

model name to the actual model used in GX Works3 and then configure the parameters. 
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The conversion results are displayed in a worksheet. Parts that cannot be handled by GX Works3 

requires separate action. 
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4 

7) The following message appears when a process CPU (QnPHCPU) project is selected. In such a 

case, change the PLC type to a universal model process CPU in PX Developer (described in step 8) 

and later). 

 
 

8) Open the project file to be converted in PX Developer and select [Change PLC Type]. 

 
 

9) Specify the universal model process CPU (QnUDPVCPU) and click [OK]. 

 
 

10) Click [Yes]. 
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11) Execute cold-start compile. 

 
 

Example of actions taken after converting and opening PX 
Developer format projects 
The following shows the process example of changing the model name of a module replaced with a 

general intelligent module to a thermocouple input module (R60TD8-G) and then replacing the module 

FB of PX Developer with devices with configured refresh settings. 

 

1) On the "System Parameter" window, open "I/O Assignment Setting". 

 
 

  



 

 
4 REPLACING MELSEC-Q SERIES WITH MELSEC iQ-R SERIES 

4.2 Replacement from PX Developer Format Project 25 

4 

2) Open the module model name menu and select "R60TD8-G" (module type: temperature input, 

module model name: R60TD8-G). 

 
 

3) On the parameter (module information) window for R60TD8-G, configure the refresh setting for the 

measured temperature value. 

 
 

4) In the same manner, configure the refresh setting for the digital value on the parameter (module 

information) window for R60DA4(Q). 
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5) Input the devices for which refresh settings are configured into the program. 
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5 DOWNLOAD 
Manuals, software, and sample libraries can be downloaded from the MITSUBISHI ELECTRIC FA Global 

Website. 

5.1 Manuals 
Manuals listed in this chapter can be downloaded from the following link. 

https://www.mitsubishielectric.com/app/fa/download/search.do?kisyu=/plcr&mode=manual 

 

5.2 Software 
 

MELSEC iQ-R software 

https://www.mitsubishielectric.com/fa/download/index.html 

1. Download Target → Software → Please select the country / region where you currently live. 

■ Configuration and programming product 

GX Works3 Version 1 

 

■ Firmware 

Firmware update information file for R08PCPU, R16PCPU, R32PCPU, and R120PCPU 

Firmware update information file for R6RFM 

Firmware update information file for RJ71EN71 

Firmware update information file for RJ71GP21-SX and RJ71GP21S-SX 

Firmware update information file for RJ71GF11-T2 

Firmware update information file for RJ61BT11 

 

■ Field device management and configuration software 

MELSOFT FieldDeviceConfigurator 

 

■ DTM 

HART CommDTM: M_CommDTM-HART 

 

MELSEC-Q software 

https://www.mitsubishielectric.com/fa/download/index.html 

1. Download Target → Software → Please select the country / region where you currently live. 

 

■ Configuration and programming product 

PX Developer Version 1 

PX Developer Monitor Tool Version 1 

  



 

 

 
Created in March 2026 
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